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Product Warranty Statement

ELECTRONZ LTD – LIMITED LIFETIME WARRANTY

All Engine Control Units (ECUs) manufactured or distributed by Electronz Ltd are subject to the 

following LIMITED LIFETIME WARRANTIES, and no others.

Electronz Ltd warrants only to the original purchaser of the ECU, for the lifetime of the ECU, (subject to

the limitations set out below), that the ECU shall be free from defects of materials and workmanship in the

manufacturing process. This warranty ceases to apply and does not apply to ECUs that have not been

manufactured or distributed by Electronz Ltd for a period of greater than one year.

An ECU claimed to be defective must be returned to the place of purchase. Electronz Ltd, at its sole option,

may replace the defective ECU with a comparable new ECU or repair the defective ECU. 

This limited lifetime warranty is not transferrable and does not apply to any ECU not properly installed or

properly used by the purchaser or end user, or to any ECU damaged or impaired by external forces. The

above warranties are the full extent of the warranties available on the ECU. Electronz Ltd has no liability to

the original purchaser or any other person for any loss, injury or damage to persons or property resulting

from the use of the ECU or any failure of or defect in the ECU whether by general, special, direct, indirect,

incidental, consequential, exemplary, punitive, or any other damages of any kind or nature whatsoever.

Electronz Ltd specifically disclaims and disavows all other warranties, express or implied, including, without

limitation, all warranties of fitness for a particular purpose, warranties of description, warranties of

merchantability, trade usage or warranties of trade usage.

For off-road use only, not intended for highway vehicles. This ECU contains a user-configurable software

programme, which is updated by Electronz Ltd from time to time. The user must ensure the current correct

version of this programme is downloaded from the website of Electronz Ltd and installed in the ECU prior

to use. This limited lifetime warranty does not apply where the ECU has been installed with the incorrect

version of the software programme. The user is solely responsible for the setup and testing of all

user-configurable features. 

Electronz Ltd License Agreement

The software programme in this ECU is licensed not sold. Electronz Ltd grants the user a license for the

programme only in the country where the programme was acquired. No other rights are granted under

this license and the programme may only be used on one machine at a time. If the

programme is transferred a copy of this license and all other documentation must be transferred at the

same time. The license may be terminated by the user at any time. Electronz Ltd may terminate the licence

if the user fails to comply with the terms and conditions of this license. In either event the copy of the

programme must be destroyed.
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1 Introduction

Thank you for purchasing your Vi-PEC Plug-In Engine Control Unit (ECU).  Vi-PEC i-Series ECUs are an
advanced, fully programmable microprocessor controlled Engine Management System.  

The i-Series software platform boasts an impressive list of features giving a new level of user adjustment.
 This flexibility allows the tuner to have complete control over the engine management system.   i-Series
software employs high resolution fuel and ignition tables with configurable load and RPM centres.  When
coupled with up to six dimensional fuel and ignition mapping, barometric pressure compensation and
intake air temperature correction this gives an unprecedented level of tuning accuracy.  All Vi-PEC i-
Series ECUs are in field upgradeable, there is no need to return the unit for software updates.

All Vi-PEC i-Series Plug-In Engine Management Systems are designed with flexibility and ease of
installation in mind.  Vi-PEC Plug-In systems are designed to either replace the circuit board inside the
factory ECU enclosure, or entirely replace the factory ECU.  This provides an invisible install that
requires minimal modification to vehicle wiring and ECU mounting.

Vi-PEC Engine Management Systems are designed with the final result in mind.  Not only do they boast
an impressive range of performance features, but are designed with a focus on safety, reliability and
drive-ability.  However, the ultimate success of your engine management upgrade is determined by how
well the system is installed and tuned.

Installing and tuning any after market engine management system is not to be taken lightly.  i-Series
ECUs give the tuner the control & flexibility that only top after-market engine management systems in
the world can provide.  While every effort has been made to keep i-Series ECUs as user friendly as
possible, it should be recognised that added features bring added complexity.

The complete setup of your ECU can be divided into two  important tasks:

1. This manual covers the installation of your i-Series ECU.  While it is not strictly essential that this
work is performed by an automotive electrician, the knowledge and tools available to these
professionals makes it highly recommended. Regardless of who does the installation, it is of utmost
importance that instructions provided in this manual are followed exactly throughout the installation.

2. Once the i-Series ECU has been installed it will need to be tuned using a laptop computer with iVTS
software.  Information on the configuration and tuning of the i-Series ECU is detailed in the online help
section of iVTS.  i-Series ECUs are shipped pre-loaded with a base configuration that should be close
enough to get most engines running after a few application specific adjustments have been made. 
While hearing the engine running on the new ECU for the first time is always a satisfying feeling, it is
important to realise that the job is not complete.  The amount of tuning performed and the experience
of the tuner are the two most important factors in determining how happy you will be with your engine
management system.

1.1 Safety Notice

Your Vi-PEC Plug-In ECU is designed to enhance the performance of your vehicle.  However in all
cases, your vehicle must be operated in a safe manner.  Do not tune your vehicle while operating it on
public roads.  Obey road rules at all times.

WARNING!

Failure to follow all installation and operating instructions may result in
damage to the Vi-PEC ECU, personal injury, or harm to property.

1.2 Disclaimer

All care has been taken to ensure the pin outs and interconnections of the ECU to the vehicles wiring
harness are correct.  However due to variations between vehicle models it is the installers responsibility
to check wiring connections BEFORE installing the ECU.  Vi-PEC will not be held responsible for any
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damage caused by the incorrect installation of this product.

1.3 Support Options

Should any issues arise during installation, the following options exist for technical support:

1. iVTS help, press F1 while running iVTS

2. Contact your nearest Vi-PEC dealer.  A Vi-PEC dealer list is available on our website.

3. Vi-PEC website:  www.vi-pec.com

4. Technical Support Email:  support@vi-pec.com

5. Online Discussion Forum: Available from the Vi-PEC website.

The majority of questions received by the technical support team are clearly answered in the manuals.
To speed up your technical inquiry please consult the manuals to make sure that your question has not
already been answered.



Pre-Installation 7

© 2014 Vi-PEC

2 Pre-Installation

Before installing theVi-PEC i-Series ECU into the vehicle some pre-installation checks must be
performed. 

2.1 Injector Impedance

Injector impedance is important and needs consideration before installing the ECU.

2.2 Internal Igniter

2.2.1 BMW Mini Cooper S R53 Internal Igniter

The BMW Mini Cooper S R53 i-Series plug-in ECU is equipped with internal ignitors to meet the
requirements of the factory wiring loom. (This means that ignition coils are wired directly to the ECU).

The internal ignitor can drive 10 amps of current through each ignition channel. It is important not to
exceed this current when setting dwell times or fitting aftermarket coils. Internal ignitors are only present
on IGN 1 and IGN 2
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3 Installation

This guide provides information on correctly and safely installing your new Vi-PEC i-Series Plug-In ECU.

3.1 ECU Handling Procedures

WARNING!!!
The following installation process will require handling of both the Vi-PEC ECU
and factory ECU. Both of these are highly sensitive to electrostatic discharge

and are easily damaged. Follow the anti-static precautions given in this
manual carefully to avoid damaging electronic components. Warranty claims

for ECUs damaged by electrostatic discharge will NOT be accepted.

ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around. This charge can reach very
high voltages. Whenever given the opportunity this energy will attempt to discharge

(usually through your finger tips!). This can be fatal to most electronic components. Most
people have experienced an electrostatic discharge when they step out of their car or

touch a metal bench top. 
1. The following guidelines describe precautions that can be taken to reduce the possibility

of damaging your ECU:
2. Work only on a conductive surface. A clean steel bench is suitable.

3. Always wear a wrist strap that is electrically connected to the conductive working
surface.

4. Touch the working surface regularly.
5. Do NOT touch components on the circuit board.

6. Where possible, only handle the ECU by its plastic header.
7. Do NOT carry the ECU around without anti-static packaging. 

8. Do NOT touch the bare terminals in the ECU header.
Observing the above procedures will minimise the chance of damaging the ECU. Note that

failure due to static damage often does not appear until well after it was caused.

3.2 Fitting the ECU

Information is provided to assist in fitting the ECU into the vehicle.

3.2.1 Fitting a BMW Mini ECU

Ensure you are following the given anti-static guidelines. The following steps outline the installation
procedure:

1. Remove the factory ECU from the vehicle: Ensure the key is in the OFF position and allow 10 minutes
to pass before proceeding. The factory ECU is located inside the engine bay in a black plastic case.
Unplug the wiring harness from the factory ECU and remove any mechanical fasteners holding the
ECU in place. DO NOT touch the exposed pins in the factory ECU connector. Remove the factory
ECU from the vehicle and place it to one side.
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2. Install the Vi-PEC ECU into the factory ECU's position. Reinstall any fasteners.
3. Connect the wiring loom to the Vi-PEC ECU.
4. Do NOT attempt to start the vehicle. Proceed to read through the remaining sections of this manual

first.
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4 Additional Sensors

i-Series Plug-In ECUs offer various options for the installation of additional sensors and devices.  As a
minimum it is recommended that all ECUs are installed with a Manifold Absolute Pressure (MAP)
sensor and Intake Air Temperature (IAT) sensor.  These parts can be purchased if required from your
nearest Vi-PEC dealer. 

4.1 Expansion Connector

The expansion connector is provided to allow easy connection of additional ECU inputs. An “expansion
cable” needs to be purchased from your Vi-PEC dealer. 

Important points when wiring to the expansion connector:

Do not overload the +5V Out pin. Although this is protected against ECU damage the +5V out signal
also provides power for other sensors.

Do not connect the ground pin to chassis ground. This could cause ground loops and introduce
unnecessary interference. Use this pin only to ground external sensors that are isolated from chassis
ground.

4.1.1 BMW Mini Cooper S R53

The following expansion connector inputs/outputs are provided:

Aux1 Auxiliary Output

DI8 Digital Input

DI9 Digital Input

An Temp 3 Temperature sensor input

An Temp 4 Temperature sensor input

An Volt 10 Analog 0-5V input

An Volt 11 Analog 0-5V input

+5V Out Low Current +5V Supply

GND Sensor Ground Only 

In order to install an expansion cable to the ECU a 10 mm diameter hole will need to be drilled in the
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ECU case. Remove the top half of the ECU case from the ECU when drilling the hole. See the photo
below for details on where to drill the hole. Also shown in the photo is the location for a CAN cable to be
connected to the ECU. If installing a CAN cable, unscrew the ECU case halves, remove the rubber bung
and then run the CAN cable in the hole left vacant.

Expansion and CAN cables can be purchased from your Vi-PEC dealer.
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5 PC Tuning

i-Series ECUs require PC/laptop tuning using the iVTS Tuning Software application running on a
Windows based computer.  iVTS may be downloaded from www.vi-pec.com. Note that when new
versions of iVTS are released they are posted on the website and may be downloaded at no cost.  Also
note that i-Series ECUs must be used with the correct version of iVTS.

IMPORTANT!
The i-Series ECU has on board USB.  

BEFORE connecting the ECU to your laptop, the USB drivers must be
installed.  Failure to install the drivers on your laptop first may result in

windows assigning incorrect drivers.  These drivers will not work with the i-
Series ECU and are difficult to uninstall.  The correct USB drivers are installed

as part of iVTS installation, as described in the following section.  Should
internet download not be practical, a copy of the drivers on CD can be

obtained from your nearest Vi-PEC dealer.

5.1 Installing iVTS

Due to the frequent updates iVTS is no longer shipped with each ECU.  You will be required to download
the latest version of iVTS from: www.vi-pec.com

Should access to an Internet connection be impractical, the latest version of iVTS can be requested from
your nearest Vi-PEC dealer on CD.

Installing from the web

1. Go to the above website and navigate to the downloads and software updates section.
2. Download the latest version of iVTS.  When prompted to run or save the file, select save.  It is

recommended to save this file on the desktop.
3. Double click the saved file and follow on screen instructions.
4. When prompted to install USB drivers, select yes.  This may take some time.
5. When installed, open iVTS by double clicking on the icon that has been placed on the desktop.
Installing from a CD

1. Insert the iVTS disk into you computer’s CD ROM drive.
2. Open 'My Computer'
3. Double click your CD ROM drive.
4. Double click the file labelled iVTSSetup.exe (or similar name).
5. Follow the on screen instructions.
6. When prompted to install USB drivers, select yes.  This may take some time.
7. When installed, open iVTS by double clicking on the icon that has been placed on the desktop.

5.2 Communicating With Your ECU

After iVTS installation, you will be able to connect  the i-Series ECU to the laptop to perform set-up and
tuning work.

1. Connect the ECU to your laptop using a Vi-PEC i-Series ECU USB Cable.  If not supplied with the
ECU, these can be purchased from a Vi-PEC dealer.  No other adapter or cabling is required. 
Connect the cable to the connector labelled USB.

2. If this is the first time you have connected a i-Series USB ECU to your laptop follow the driver
installation instructions that appear.  When prompted if you want to install drivers select 'Continue
Anyway'.

3. Start iVTS by double clicking on the iVTS icon on the windows desktop.
4. Switch the key to the ON position.  This will provide power to the ECU.
5. In iVTS, under the 'Options' menu, select 'Connection'.  The connection options dialogue will open. 

Select the correct COM Port number from the drop down list or select auto for automatic com port
detection.

6. iVTS offers both mouse and keyboard control. To establish a connection between the PC and ECU
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press the F3 key.  The same process can be used to disconnect.  If a successful connection is
established, iVTS will download settings from the ECU, otherwise you will be warned that an error has
occurred.

7. Make sure the connection shows “ONLINE” in the top right corner of iVTS.  
8. To permanently STORE any changes made to the ECU press F4.  If this is not done before turning

the ECUs power off all changes made will be lost.
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6 Pre-Start Configuration

Before starting the vehicle, important pre-start configurations need to be made.

6.1 Firmware Version

It is recommended that the Vi-PEC i-Series ECU is running the most up to date firmware. Firmware
version information can be obtained by connecting to the ECU with  iVTS and selecting 'ECU Information'
under the Help menu.

The latest firmware can be downloaded from our website with iVTS. 

It is recommended that this is performed by an experienced Vi-PEC dealer as new features may need to
be properly configured.

The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu in iVTS.
Follow the on screen instructions to complete the firmware update process.

6.2 Base Configuration

All i-Series Plug-In ECUs are shipped with base configuration settings.   Note that these are provided to
reduce initial setup and tuning times.  They are NOT recommended tuning values.  iVTS includes base
configurations for various models.  Download the appropriate base configuration into your ECU with iVTS
by connecting to the ECU (described in the Connecting To iVTS section of this manual), then selecting
'Open' under the 'File' menu.  Select the appropriate .pcl file and then select 'Open'.  Downloading large
configuration files can take up to a few minutes.  Be patient and acknowledge any messages iVTS
shows.

6.3 MAP Sensor Calibration

At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should always match
the Barometric Absolute Pressure (BAP) Sensor.  As well as providing altitude correction, the BAP
sensor also allows the MAP sensor to be calibrated prior to tuning.

Vi-PEC i-Series ECUs use an on-board barometric sensor that is calibrated prior to dispatch.  This
ensures that all iVTS Tuning Software programs (pcl Files) give a consistent state of tune throughout the
ECU range.  This allows a PCL file to be transferred between i-Series based ECUs giving an equivalent
state of tune providing all factors affecting volumetric efficiency are equal.

Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor there would be
significant affects on the accuracy of the resulting tune, especially when tuning with Manifold Gauge
Pressure (MGP) as a load index.

To calibrate the MAP sensor:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using iVTS.

2. Under the Analog Channels menu, select the An Volt channel that has been wired to the MAP
sensor.  Select the correct MAP Sensor Type.

3. Under the 'Options' menu, select 'MAP sensor calibration'.

4. Follow the on screen instructions.

5. Select the 'Analog Inputs' tab in the runtime values section of iVTS (lower part of the screen).

6. Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).

7. Perform a 'Store' by pressing F4.

6.4 TPS Calibration

The Throttle Position Sensor (TPS) is used by the ECU to calculate various engine management
parameters used by functions such as idle speed control,acceleration enrichment and motor sport
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features.  It is important that the ECU knows when the throttle is open and closed (or part way in
between). The following procedure calibrates the ECU to match the TPS and is for engines using a cable
driven throttle:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using iVTS.

2. Under the Analog Channels menu, ensure that the correct An Volt channel is set to 'TPS (Main)'.
Refer to the pin functions section of this manual for details.

3. Under the 'Options' menu, select 'TPS calibration'.

4. Follow the on screen instructions.

5. Select the 'Analog Inputs' tab in the runtime values section of iVTS (lower part of the screen).

6. Ensure the Throttle Position value reads 0% when the throttle is closed and 100% when fully open.

7. Perform a 'Store' by pressing F4.

For engine setups that use Electronic Throttle Control the Foot Position Sensor (FPS) and Throttle
Position Sensor (TPS) need to be calibrated. 

For Vi-PEC Plug-in ECUs see iVTS Help > i-Series ECU Tuning Functions > Electronic Throttle >
Electronic Throttle Control TPS and FPS Calibration

6.5 IAT Sensor Selection

This section only applies when an Intake Air Temperature (IAT) sensor has been wired and fitted to the
intake system.  It is important that the ECU is calibrated to match the sensor installed in the engine.
This procedure is as simple as selecting the correct sensor type as follows:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using iVTS.

2. Click on 'Analog Channel' in the configuration tree.

3. Select the An Temp channel the sensor has been wired to.

4. Ensure that channel (and only that channel) is set to 'Inlet Air Temperature'.

5. Select the correct 'Temp Sensor Type'.

6. Select the 'Analog Inputs' tab in the runtime values section of iVTS (lower part of the screen).

7. Ensure that IAT reads the correct temperature.

8. Perform a 'Store' by pressing F4.

6.6 Input and Output Setup

As the Vi-PEC i-Series Plug-In ECUs are designed to run several models there are a few items that
must be set-up to make the ECU specific to your model. 

The Pin Functions section of this manual gives a list of the functions of each channel based on the
target vehicle.

It is the tuners responsibility to make sure that the following channels are set-up correctly for the vehicle
model the ECU is fitted to:

All Auxiliary Output Channels 

Use the 'Test On' or 'Test PWM' (at 10 Hz) functions to test the wiring of channels.

All Digital Inputs

Look at the Digital Inputs runtime values (lower section of the iVTS screen) to confirm each channels
operation.

All Analog Volt and Temperature Inputs

Look at the Analog Inputs runtime values (lower section of the iVTS screen) to confirm each channels
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operation.

6.7 Trigger Calibration

The following instructions assume that all pre-start set-up instructions given in previous sections have
been completed.  Only after all pre-start checks have been made should an attempt be made to crank
the engine.  The following steps must be performed before an attempt is made to start the engine to
ensure the i-Series ECU is calibrated to precisely measure engine position.

1. Connect the ECU to iVTS.

2. Select 'Fuel', then 'Fuel Set-up':
a. Set ‘Injection Mode’ to OFF.  This will prevent the engine from trying to start while the triggers are

calibrated.
b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU is lost.

3. Click on ‘Triggers’ then ‘Calibrate Triggers’.
4. Perform the correct trigger calibration procedure specific to your vehicle as described in the iVTS

online help (Press F1).
Note that trigger calibration must be performed again once the engine is running.  Due to the
acceleration and deceleration of the crankshaft at low speeds, an inaccurate measurement of engine
timing is usually made.  Also it is often harder to see timing marks with a timing light at slow engine
speeds.  Trigger calibration should be checked again at between 2000-4000 RPM where engine speed is
stable and a more consistent timing reading can be obtained.
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7 First Time Startup

After performing all set-up instructions given in previous sections, including trigger calibration, the engine
is now ready to be started.  The following procedure should be used for first time start-up.

1. Turn the ignition key OFF then ON. The fuel pump should prime momentarily upon power up.

2. Connect the ECU to iVTS.

3. Access the runtimes values by pressing the F12 Key, click the 'Analog' tab:

a. TPS – spans from 0 to 100% when throttle is pressed.  If not, perform a TPS Calibration.

b. MAP – should read approx 101 kPa (at sea level) with the engine not running.  If not, check the
MAP Sensor Type setting and perform a MAP Calibration.

c. ECT – should read current engine temperature.

d. IAT – should read current intake air temperature.

e. Digital Inputs (click the 'Digital' tab) – Operate switches connected to any digital inputs while
watching the runtime value to ensure they operate as expected.

4. Rectify any faults found in Step 3.

5. Locate the 'Master Fuel' setting. This can be found in the ECU Settings Menu under: Fuel > Fuel
Setup > Fuel Main.

a. This will need to be adjusted during or just after start-up.

6. Crank the engine until it starts.  Some throttle may be required for first time start-up due to imperfect
tuning.  If necessary adjust the Master setting to enrich/lean the engine (increase to enrich).

7. If the engine fails to start after several attempts, do not crank it endlessly.  Stop and determine the
problem before continuing.

8. Check the Trigger Error Counter (found under the Triggers  runtime values tab).  If this value increases
during cranking/running then there is a trigger setup fault.  It is not unusual for this number to count
one or two on the first engine revolution.

9. Once the engine starts, adjust the ‘Master’ (under fuel settings) setting to achieve best possible
running.

10.The engine should now be allowed to fully warm up.  It may be necessary to readjust ‘Master’ several
times to maintain smooth running.  Don’t forget to keep an eye on engine temperature.

11.Once the engine is warmed up and running well, perform another trigger calibration (known “as setting
the base timing”).

12.Perform a Store by pressing F4.

7.1 Final Checks

To avoid potential engine damage and wasted time, the adjustments presented in the following sections
must be made before attempting to start the engine.  

For further help on any of the settings discussed below, consult the online Help in the iVTS Tuning
Software.  Online help can be invoked by pressing F1, or right clicking any item and selecting ‘What’s
this?’.

Pre-set-up Checks

Before attempting to configure the ECU, ensure the following tasks have been completed:

1. Ensure the ECU and all associated components are connected and correctly wired/installed.  
2. Fully charge the vehicle’s battery, as the engine will be required to be cranked during the set-up

procedure.
3. Check all oil and water levels are correct.
Connecting to iVTS Tuning Software

   Use the following procedure to establish a connection between your Vi-PEC ECU and iVTS Tuning
Software tuning software.
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1. Make sure your laptop battery is fully charged or plugged in to mains power.
2. Connect the ECU to your laptop and connect to iVTS Tuning Software as described in the

'Communicating with your ECU' section of this manual. 

7.2 Essential Tuning Adjustments

It is assumed that at this stage all set-up procedures described in previous sections have been
completed and the engine is running.  The following steps detail correct set-up procedures for some of
the more critical ECU parameters (note that MAP Sensor Calibration should have already been
completed by now):

Injector Voltage (Dead-time) Correction

There is always a delay between the injector being energised and the injector actually opening. 
Likewise, there is a small delay between the injector being de-energised and the injector closing.  The
opening time is considerably longer than the closing time, however the overall result is that less fuel will
flow for a given pulse width than would be expected with an 'ideal injector'.  To compensate for this the
injector pulse widths are increased to compensate for this 'dead-time'.  The dead-time for a given injector
is a function of the battery voltage, differential fuel pressure and the type of injector driver (saturated or
peak and hold).  A typical dead-time at 3 Bar differential fuel pressure and 14 volts is just under 1ms (ms
= millisecond = 1 thousandth of a second). 

In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the differential fuel
pressure (difference between manifold pressure and fuel pressure) will be constant.  Therefore the only
variable that is changing will be the battery voltage (this changes with electrical load and sometimes
engine speed).  Without correction, the changes in dead-time will cause the engine to run lean when the
voltage drops.  If the Injector Voltage Correction is properly set-up then changes in the battery voltage
will not affect the air/fuel ratio.

The injector dead-time table allows the dead-time for different battery voltages to be entered.  The values
represent the dead-time in milliseconds.  These should increase with falling system voltage.

Injector dead-time for a particular set of injectors can be determined using a flow bench or on a running
engine.  

To determine the injector dead-time using a flow bench, the injectors need to be operated at the intended
operating pressure (normally three bar) and at a constant duty cycle as well as a set voltage.  Vary the
supply voltage to the injector and measure minimum pulse width at which the injectors will flow for a
particular voltage.  This is the required dead-time for that injector at that tested voltage. 

To determine injector dead-time on a running engine, with the engine fully warmed and operating at
stable air/fuel ratios (a very precise AFR meter is required – a narrow band O2 sensor will not suffice),
electrical drain needs to be applied to the system; the preferred method is disconnecting the alternator
main fuse.  Battery load testers are also useful here too.

Watching the air fuel ratios change while the battery voltage drops, the dead-time table can be trimmed
to maintain the same stable air/fuel ratio.  Injector dead-time can be viewed as a row graph.  A smooth
curve needs to be maintained at all times.

NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector dead-times.

Master

Master should be set so that the numbers in the middle of the fuel table end up around a value of 50. 
This is to allow sufficient span of the numbers in the main fuel table.
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8 Pin Functions

A list of pin functions is provided, this is useful when configuring your ECU through iVTS.

8.1 BMW Mini Cooper S R53

BMW Mini Cooper S R53 PCB V1.0 BMW Mini Cooper S R53 PCB V1.1

Auxiliary Outputs

Aux 1 Expansion Connector Expansion Connector

Aux 2 Leak Diagnostic Pump Solenoid Leak Diagnostic Pump Solenoid

Aux 3 Purge Solenoid Purge Solenoid

Aux 4 -

Aux 5 Gear Shift Interlock Gear Shift Interlock

Aux 6 A/C compressor Relay A/C compressor Relay

Aux 7 -

Aux 8 -

Aux 9 E-Throttle + E-Throttle +

Aux 10 E-Throttle - E-Throttle -

Aux – Ignition Outputs

Aux - Ign 3 Engine Fan Ign 3 (Pin 1)

Aux - Ign 4 Engine Fan 2 Ign 4 (Pin 2)

Aux - Ign 5 Fuel Pump Relay Fuel Pump Relay

Aux - Ign 6 Engine Fan

Aux - Ign 7 Engine Fan 2

Aux – Injection Outputs

Aux - Inj 5 O2 Sensor #1 Heater O2 Sensor #1 Heater

Aux - Inj 6 O2 Sensor #2 Heater O2 Sensor #2 Heater

Analog Channels

An Volt 1 MAP - Post Supercharger MAP - Post Supercharger

An Volt 2 MAP - Pre Supercharger MAP - Pre Supercharger

An Volt 3 Accelerator Pedal Position #A Accelerator Pedal Position #A

An Volt 4 Accelerator Pedal Position #B Accelerator Pedal Position #B

An Volt 5 Throttle Position #A Throttle Position #A

An Volt 6 Throttle Position #B Throttle Position #B

An Volt 7 O2 Sensor #1 O2 Sensor #1

An Volt 8 O2 Sensor #2 O2 Sensor #2

An Volt 9 A/C Pressure A/C Pressure

An Volt 10 Expansion Connector Expansion Connector

An Volt 11 Expansion Connector Expansion Connector

An Temp 1 ECT ECT

An Temp 2 IAT IAT

An Temp 3 Transmission Oil Transmission Oil

Digital Inputs

DI 1 Alternator Load Alternator Load

DI 2 Cruise Control PWM Cruise Control PWM

DI 3 Clutch Sw itch Clutch Sw itch

DI 4 Brake Light Sw itch Brake Light Sw itch

DI 5 Brake Light Sw itch Test Brake Light Sw itch Test
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DI 7 OBD2 Plug (Pin 9) OBD2 Plug (Pin 9)

DI 8 Expansion Connector Expansion Connector

DI 9 Expansion Connector Expansion Connector

DI 10 Leak Diagnostic Pump Sw itch Leak Diagnostic Pump Sw itch
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9 Pinouts

Pin information is provided to assist when troubleshooting. All pinouts are looking into the ECU (wire
side).

9.1 BMW Mini Cooper S R53

Pin ECU Function PCB
V1.0

ECU Function PCB
V1.1

Pin ECU Function PCB
V1.0

ECU Function PCB
V1.1

1 Not connected Ign 3 54 DI 2 DI 2

2 Not connected Ign 4 55 Trig 1 Trig 1

3 Ign 1 (Internal Ignitor) Ign 1 (Internal Ignitor) 63 Aux 9 Aux 10

4 Ign 2 (Internal Ignitor) Ign 2 (Internal Ignitor) 64 Aux 9 Aux 10

5 Inj 5 Inj 5 65 Aux 10 Aux 9

8 Knock 1 Knock 1 66 Aux 10 Aux 9

9 An Volt 7 An Volt 7 85 DI 3 DI 3

10 An Volt 5 An Volt 5 88 Ign 3 Ign 6

11 An Volt 6 An Volt 6 90 An Volt 9 An Volt 9

19 Inj 4 Inj 4 93 DI 10 DI 10

20 Inj 2 Inj 2 94 Aux 6 Aux 6

21 Inj 1 Inj 1 95 Ign 4 Ign 7

22 Inj 3 Inj 3 96 Aux 5 Aux 5

24 Aux 3 Aux 3 98 DI 4 DI 4

25 An Temp 3 An Temp 3 99 DI 5 DI 5

26 An Temp 1 An Temp 1 101 DI 6 DI 6

27 An Temp 2 An Temp 2 105 Ign 5 Ign 5

29 An Volt 2 An Volt 2 107 An Volt 4 An Volt 4

31 An Volt 1 An Volt 1 108 An Volt 3 An Volt 3

42 Aux 2 Aux 2 109 An Volt 8 An Volt 8

43 Inj 6 Inj 6 110 CANH2 CANH2

52 DI 1 DI 1 111 CANL2 CANL2

53 Trig 2 Trig 2 113 DI7 DI7
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10 CAN Information

The following CAN (Controller Area Network) information is provided:

10.1 BMW Mini Cooper S R53 CAN

The Vi-PEC BMW Mini Cooper S ECU receives the following information over the vehicles CAN
(Controller Area Network).

CAN Channel Function

CAN Freq/Spd 1 LH Front wheel speed

CAN Freq/Spd 2 RH Front wheel speed

CAN Freq/Spd 3 LH Rear wheel speed

CAN Freq/Spd 4 RH Rear wheel speed

CAN DI 1 Bonnet open

CAN DI 2 Handbrake on

CAN DI 3 Seatbelt on

CAN DI 4 DSC switch

CAN DI 5 Headlights on

CAN Volt 1 Steering wheel position

CAN Volt 2 Steering rate

Not displayed in iVTS Aircon request flag
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11 Known Issues

All plug-in ECUs are fully tested on a range of relevant vehicles, although there are often variations that
have not been tested. For this reason issues can arise. 

WARNING: Always download the latest Installation Manual from vi-pec.com and check the latest status
of known issues before installing the ECU.

Please contact your nearest Vi-PEC dealer when suspecting a compatibility issue.

11.1 BMW Mini Cooper S R53

There are currently no known issues.
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